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Abstract: Thisdocument introduces users to the Microsoft Access
relational database management system, which allows for the
creation, organization and manipulation of large quantities of
data. This classwill concentrate on creating a blank database,
creating and importing tables into the database, establishing
primary and foreign key fields, entering records into tables,
sorting fields in tables, and filtering for specific recordsin
tables. It will also introduce users to setting up different types of
relationships between tables and enforcing rules on those
relationships.
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Introduction

The Access database program allows for the creation, organization and manipulation of
large quantities of data. The basic building block of any database is the table, built of
distinct and unique rows of information (called records), each of which are broken down
into one or more columns (or fields) of predetermined and consistent size and type of
data. Asarelational database, an Access database can contain many tables, where the
records in one table may be related to records in other tables.

Objectives

The goal of this workshop isto introduce participants to Access. After today's workshop,
participants will be able to:

e Create anew, blank database

e Create new tablesin design view and import tables
e Enter and delete records

o Edit table design

e Display and organize datain atable

e Create and edit relationships

Prerequisites
Database Design workshop or equivalent skills.

Related Training Available from ACS

All workshops offered by Academic Computing Services (ACS), adivision of
Information Services, are freeto KU students, staff, faculty, and approved affiliates. The
general public is also welcome to most workshops, but some ACS workshops require a
registration fee for them.

To learn more about or register for workshops, receive automatic announcements of
upcoming workshops, and track workshops you’ ve registered for and have attended, visit
the ACS Web site at www.ku.edu/acs/train. Y ou can also check our online schedule at
www.ku.edu/acs/schedule for alist of class offerings and their availability. For further
workshop related questions, please email training@ku.edu.

ACCESS: INTERMEDIATE

This three-hour, hands-on workshop introduces queries and pivot tables and charts.
Participants learn creating select queries between multiple tables and adding criteria as
well as how to create and utilize pivot tables and charts based on query data.
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Definitions

Term Definition

Database | An organized collection of information.

Relational | A management system that allows the definition of data structures,
Database | storage and retrieval operations and rules to preserve data quality
(integrity constraints).

Table An object comprised of fields (columns) that collect records (rows of data)
about a specific topic.

Field A table column that stores specific information and when combined with
other fields (columns), makes up a record.

Record A row in a table that is a collection of related data treated as a unit.

Primary One or more fields whose value or values uniquely identify each record in
Key a table.

Foreign One or more table fields that refer to the primary key field or fields in
Key another table.

Query An object that can allow for the retrieval, display, and updating of data
from one or more related tables.

Form An object designed primarily for the display and/or entry of data into a
table, query, or other Access object but that can also be used for other
execution purposes.

Report An effective way to present data in a printed format from a table, query, or
SQL statement.

Data A special type of web page especially designed for viewing and working
Access with data (stored in an Access database, Microsoft SQL Server database,
Pages or some other type of database) from an Internet or intranet

Macro An action or set of actions used to automate tasks.

Module An object that contains a collection of Visual Basic for Applications (VBA)
declarations and procedures that are stored together as a unit.
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Planning for a Relational Database

Because Accessis arelational database management system, the database table and
relationship structure should be planned out befor e creating the actual physical model.
The Database Design workshop introduces the fundamental principles of database design

and is a prerequisite to this workshop.

Creating a New Blank Database

Y ou can create a new database severa different ways. from an Access template, based
on an existing database, and using a Blank Access database. To create a new database
and design your own objects use the blank database method.

1. Open Access

2. Ontheright side of the window under New, select Blank Database.

Mew File v

Open a file
Class.mdb
Advanced2000.mdb
lit_resvieww, mdb
R&Barant_TEST.mdb
= More files...

Mew
[# r;.jlank Database
[F¥—filank Data dccess Page
[#] ] Project (Exisking Daka)
IEH Project (Mew Data)

Mew from existing file
|_J-_ﬂ Choose file...

Mew from template
[#] ] izeneral Templakes, .,

%] ] Templakes on Microsoft, com
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3. Choose alocation to save your database and name your database by typing over

dbl.mdb.
File New Datahase @
Save in: |B P Introduction ﬂ & 5 + Toals -

@Classlntrnductiun ndb
]

History

B

My Docurnents

=

Deskiop

X

Favorites

Filz narme: db1.radb I ﬂ Create |
' |
Save as type: |Microsoft Ac%ases *.mdb} j Cancel

Note: The.mdb file extension will be added automatically to whatever file
name you choose.

4. After naming your database, click the Create Button.
5. Accesswill create your database and open up the database window.
6. Now you are ready to create tables in your database.

Note: Onceyou name your database and click on Create, the database is
saved. Asyou design objectsin your database (tables, queries, forms,
reports, and macros) you must click on the save button to save design
changes. Once the objects are created and saved, any records you add
to your database will be automatically saved. Because of this, you
will not have many “undo” opportunities in datasheet view. However,
when designing your tables, you will have multiple undo
opportunities.
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The Database Window

Y our database window is now displayed to you in Access. Its purpose s to provide you
access to the objectsin your database and allow you to create new ones. To close that
Access database and open a different database, you click on the corner x of the window
or choose File=»Close like you would in any other Office program. To open a database
file, click the yellow folder on the Database toolbar, or File=»Open, just asin any other

Office program.

e= EmployeeProject : Database (Access 2000 file format) D@E|
G cpen B pesion “tiew | | 2o - [EE|E
Objects reate bable in Design view
Tables Create table by using wizard
Queties Create table by entering data
Farms
=] Reports
@ Pages
I Macros
ﬁ?’& Modules
Groups
(#] Favorites

Note: Inthe Access program, you cannot have more than one database open
at atime. If you open a database and aready have a different one
open, Access will close the first one before opening the second.
However, you can have more than one database object open at atime.
For example, you could have three different tables within the same
database open at the same time.

Creating a Table

In Access, tables are what store our information or raw data. Before you can input the
information, you must first create tables. There are quite afew ways to create Access
tables. You can create atable in design view (thisisthe most common way of table
creation), create atable using the table wizard, create atable by entering data, import
tables from other types of files, and link tables of other file types as well.
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Creating a Table in Design View

Usually, tables are produced in Design View because it offers severa benefits. Some of
these include creating field names, choosing data types, establishing field descriptions,
and setting the primary key. Properties and field attributes for each field display in the
bottom pane of the Design View window, and can also be set during thistime. To create
atablein Design view, start in the database window.

1
2.
3.

E Tablel : Table E”EE

Field Mame Data Type Descripkion ~

Click on the Tables button in the database window on the Object bar.
Double click Createtablein Design View.

The design view of a new table will open for you to start typing in field names, data
types, and descriptions.

|
| v

Field Properties

zeneral l Lookup ]

A field name can be up to 64
characters long, including
spaces, Press F1 For help on
field names,

4.

Typein thefirst field name and press Tab or Enter to move to the data type.

Note: Field names can contain letters, numbers, and/or spaces, although

spaces are not highly recommended.

Choose the data type you want from a dropdown arrow and press Tab or Enter again
to move to the description field.

The descriptions field, while optional, is good to use for documentation purposes as
well as directions to the person inputting the data.

Continue steps 4-6 until you have created all of the fieldsin your table.

Also, if you want aprimary key field, you must do thisin Design View. For more
information about primary keys, see Setting the Primary Key Field.
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Note: Make sureyou save on aconsistent basis when working in design

view. Access does not save automatically in thisview. Y ou must
click on Saveto save any changes you make in this view. For more
information about saving changes to your table, see Saving the Table
on pagell.

Choosing Access Data Types

In Access, you must assign adata type for each field. The data type determines what
values you can enter for afield and what other properties the field will have. Y ou want to
choose a data type that most closely matches the kind of data you plan on storing in that
field, especialy in larger databases. Thiswill help keep your file sizes manageable and
will optimize Access's performance. The datatypes are as follows:

Text: Usefor field values that contain letters, digits, spaces, and specia characters.
Text fields can contain up to 255 characters. The default field size for atext data
typeis50.

Memo: Usefor long text comments. Memo fields can contain up to 64,000
characters. Unlike text fields, however, you cannot search or sort records based on
the contents of amemo field.

Number: Use for numeric values. Because number fields are more restrictive than
text fields, only chose this data type for numerical entries that will be used in
calculations (e.g., percentages, quantities). Do not use this field type for currency
values (see Currency, below). The default field size for a number datatypeisLong
Integer. For more information about field sizes for number data types, pressthe F1
key on your keyboard when you are clicked in the Field Size property box.

Date/Time: Usefor dates and times. Date/time fields have a number of standard
display options, but can also be customized to display in other formats. Access
recognizes years as 4-digit numbers, even if only the final two digits are displayed.

Currency: Usefor currency values. Currency fields are similar to the number data
type, except that the decimal places and field size are predetermined, and calculations
performed using the currency data type are not subject to round-off error.

AutoNumber: Use thiswhen you want integers or a value automatically inserted in
the field as each new record is created. Y ou can specify sequential numbering or
random numbering. Using AutoNumber guarantees a unique field value, which can
serve as atable s primary key. AutoNumber fields cannot be edited.

Yes/No: Usethisdatatype for fields that indicate the presence or absence of a
condition (e.g., such as whether a person has enrolled, if their application has been
submitted, etc.) Y es/No fields store a numeric value and can display a numeric value,
text, or agraphic “check box.” The value —1 means“yes’, “true”’, or “on” and 0
means “no”, “false”, or “off.”

OLE Object: Usefor data or files that are created in other software applications,
such as photographs, video images, graphics, drawings, sound recordings,
spreadsheets, word processing documents, etc.
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e Lookup Wizard: Thisisnot adatatype, but this option will create afield that lets
you select avalue from another table or from a predefined list of values. Oncethe
list is created, Access will then set the data type for you.

Setting the Primary Key Field

While not required, every table should have a primary key field. It's good practice to
place the field or fields that will act as your primary key field first when listing your field
names, sinceit isthe only field that is required by default. Creating aprimary key
automatically creates a unique index for the field. Remember that the primary key should
be afield whose value uniquely identifies the each of the records of the table. For
example, each student’s 1D number uniquely identifies each student record.

To create aprimary key field, place your cursor in the field row and click the Primary
key button (|i) on the database toolbar. Notice that a key displays before the field row
and the index information in the lower window has changed to Indexed: Yes (No
Duplicates).

Note: You canusemultiplefieldsin atable asthe primary key field. If the
fields are adjacent, you can do this by clicking on the small gray
square before the name of the field (this will select the entire row),
holding the Shift key on your keyboard, and clicking on the gray
square to the left of the next field name. When both rows are selected,
click on the Primary key button, and a small key will appear in the
gray sguares beside both field names. If the two fields are not
adjacent, hold the Ctrl key on your keyboard instead, following the
same steps.

Removing the Primary Key Field

Each table should have a primary key field. However, primary keys will not allow duplicate
records or key values. There may be cases (such as when you are importing recordsinto a
table) when you need to alow duplication of records for a short time. To remove a primary

key:
1. Inthetable'sDesign View, select the primary key field, so the black indicator arrow

appears to the left of the field name, along with the key symbol (#¥). The primary key
button on the button bar (|i) appears pressed in.

2. Click onthe primary key button (|i) on the button bar. This removes the primary key
setting from the field and removes the indexing from the field.
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Changing the Primary Key Field

If you want to change the primary field, select the field you want to be the primary field,
and click the Primary Key button (|i) on the toolbar.

Note: If you arecreating aprimary key from afield that already has datain
it, be sure that there are no duplicate valuesin the field. If there are
duplicate values, Access will not allow you to save your changesto a
table’ s design.

Setting Field Properties

Each field in the table has its own properties, or named attributes, and behaviors that can
be set to adesired value. Some of these properties are things such asthe field size
(number of characters that can bein afield), default information, whether afield is
required (the default for all fields except the primary key field is no), and many others.

The Field Properties of each field display in the lower pane of the Design View of atable.
Access lets you know which field' s properties are being displayed by placing a black
triangle next to the active field in top half of the window:

| Field Mame | Data Twpe |
% | EmployeelD Text
T | EmployesFitsthiame Text
EmployeeMiddleInitial Texk
EmploveelastiMame Texk

To know more about specific field properties, when you click in the field beside the name
of the property you're setting, you can press the F1 key on your keyboard and Micr osoft
Access Help will open up and display the information for that property.

Saving the Table

Once you have finished designing your table and setting your primary key field, you're

ready to save. Simply click on the Save button (=) on your toolbar or click on

File=» Save and the Save As dialog box will open with Tablel inside of it. Select it, and
type the table name you want. Including the word Table or Thl before/after the table
name can help you to distinguish between objectsin alist. Also, it'sagood idea not to
include spaces in the names of your objects. This hel ps when exporting or importing
between programs, creating calculated fields, and/or writing VBA.

Importing a Table

Y ou can import atable from either another Access database or from afile created in a
different software package such as Excel or dBase. Y ou can also import text files. To
import your data into your database as a new table:

1. Click File=»Get External Data=»| mport.

2. Find thefile that you want to import. Be sure the correct file type is selected in the
Filesof Typefield at the bottom of the window (e.g. If you'reimporting atext file,
then the Files of Type field must say Text.

3. Click the Import button.
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Note: You might have to go through an import wizard, depending upon what
type of file you import.

4. If you receive a message that the import was successful click OK.

Entering and Deleting Information

Adding Records

Not only do we create objects in Access, but we also enter data into the objects that we
create. Customary places to enter data are tables and forms. Here, we will concentrate
on entering datainto our tables. While Design View isfor designing the table, Datasheet
View iswhere we create and edit records.

I EmployesWorkinfoTable ; Table [< |[E=][%]
Employeell) | EmployesFrstName | Employeshiddisingial | Employeslasibams FthimnEmEﬂjﬂF‘u:hiun

Record: 4] 4 [T 1 W [mifea]af g ‘| |

1. If youtableisalready open, switch to datasheet view of your table by clicking on the
Datasheet View button (E) on your database toolbar.

2. If you are in the Database Window, click on the Tables button on the Object bar and
double click the table you want to open.

3. Toinsert anew record, click the New Record button (I**]) on the Record Navigation
Bar at the bottom of your table. Thiswill take your cursor to the last row of the table
for you to start entering record information.

Note: TheNew Record button can aso be found on the database toolbar at
the top of your screen aswell as under I nsert=»New Record.

Usethe Tab or Enter key to move from field to field.

At the end of the row, you can pressyour Tab or Enter key to continue creating
more records or you can close your table.

6. Accesswill automatically save your changes whenever you move from one record to
another and/or whenever you close the table. Y ou do not have to click on Save to
save records.
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Deleting Records

Y ou can also delete an unneeded record or records in datasheet view of atable. To delete
arecord:

1. Select the record to delete by clicking the gray record selector to the left of the row.

2. Pressthe Delete key on your keyboard or choose Edit=»Delete Record. A dialog
box will appear asking you to confirm the deletion.

3. Click Yesto delete the record or No to cancel the action.

Note: Youcannot “undo” adeleted record.

Editing the Table Design

Once your tableis created, you may find you need to make changes to the design or
structure. Y ou can switch between Datasheet View (E) and Design View (&) by
clicking the appropriate button on the database toolbar. Y ou can also use the View menu
to switch between views.

Displaying and Organizing Data

There are many different ways for you to find and display your datain atable. You can
temporarily or permanently rearrange your columns, sort by afield or adjacent fieldsin
an Access table, and filter for records that meet specific criteriain atable. These options
can be very beneficial when trying to locate data quickly in order to edit the information.

Rearranging Columns

Y ou can rearrange the columns to place them in an order that can be temporary or
permanent. This can allow for amultiple column sort. If you want the move to be
temporary, you can do thisin datasheet view of your table and not save the changes when
closing.

1. Select the column you want to move by clicking once on the column heading.

2. Click and drag to place the column in its new position.

Sorting

In Access tables, there are a couple of waysto sort. Y ou can sort information in an
Ascending or a Descending sort order. What we sort in Access arefields. Y ou can sort
by one field or by many fields, but the fields must be adjacent. If they are not, then you
can temporarily rearrange them. Also, Access always sorts data from left to right. This
means that if you sort by more than one field, it will sort by whichever field is furthest
left and move right.

Sorting by One Field (Quick Sort)
To sort one by one column or field, do the following:

1. Placeyour cursor anywhere in the column on which you want the sort performed.
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2. Select Records=Sort, and then choose Sort Ascending or Sort Descending. Y ou
can also click the Quick Sort buttons on the database toolbar (##EH). Access sortsthe
table based upon the datain the selected column.

3. Toundo aQuick Sort, select Recor ds=»Remove Filter/Sort.

Note: Whenyou close atable, sorted records return to their previous order
unless you save the layout changes.

Sorting by Multiple Fields
To sort across multiple fields, do the following:

1. Select multiple columns by clicking and dragging across the column headings of the
columns you want to sort.

2. Select Records=»Sort, and then choose Sort Ascending or Sort Descending. You
can also click the Quick Sort buttons on the database toolbar (£#EH). Access sorts the
table based upon the data in the selected column.

Access sorts by the leftmost column first; Access then performs secondary sorts (where
there were duplicate values in the column to the left) on the remaining selected columns
to theright.

Filtering Records

One of the basic features of any database isthat it should allow you to look at a subset of
your data, based upon some criteria. For example, in an address list, you might want to
only look at address from a particular city or state.

One of the ways of doing thisin Accessiswith filters. When you filter atable in the
Datasheet View, you hide all records that don’t conform to your set of criteria. To
“unhide” the hidden records, you remove the filter.

There are two basic types of filters: Filter by Selection and Filter by Form. They differ
in the way you run the filter, and the complexity of the filter you can create.

Filter By Selection

Thistype of filter isthe easiest to perform. It allows you to view all the recordsin the
table that have the same value in a particular field.

To do aFilter by Selection:

1. Findthevauein thefield (column) that you want to filter by (e.g., find “Lawrence’
in the City field).
2. Click inthat cell sothe cell is selected or your cursor is blinking in the cell.

3. Choose Records=>Filter 2 Filter by Selection. You can aso choose the Filter by
Selection button () from the database toolbar.
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Filter By Form

Filter by Form gives you the flexibility to find records based on the valuesin multiple
fields using the And operator or Or operator, or to use selection criteriato find ranges of
values. Selection criteria are operators and values you enter into the Filter by Form.
Examples of several selection criteria operators include:

> Greater than

>= Greater than or equal to
< Lessthan

<= Less than or equal to
<> Not equal to

<>66044 This criteria would find all values not equal to 66044.

Example of selection criteria

To use Filter by Form:

1. Click Records=>Filter=>Filter by Form. You can also select the Filter by Form
button (§) on the database toolbar.

2. IntheFilter by Form mode, you can select unique values from the pull-down menus
for each field, or you can enter custom selection criteria.

3. If you are looking for more than one value in afield, click the Or tab at the bottom of
the Form.

4. If arecord must meet multiple values from different fields, continue to select or type
in the appropriate value for each field. This usesthe implied And operator.

5. Click on Filter=>Apply Filter/Sort or click the Apply Filter button (") on the
toolbar.
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Creating Relationships

Relationships are connections between tables in a database that allow many objects with
similar fields to share data. This not only creates consistency in records, it also helps keep
the size of the database manageable by reducing the duplication of data. Relationships
also allow you to display fields from multiple tablesin aquery or report.

The basic ideaisthat alink can be created between two tables that have the same fields
and one of those fieldsis aprimary key in the primary (or parent) table. Thiswill allow
you to reference data in the other table through that link. For example, an employee table
that contains employee work information could be linked to atable of projects that
employees are assigned. The employee work table would contain information about the
employee, such as an employee ID, employee first and last name, their hire date, salary,
and other work related information. The assigned project table would have information
directly related to an employee assigned to a project, such as a project ID, the employee
ID, date the employee started and ended on a particular project, and any other
information that pertained to the employee working on a project. Through a common
field, such as employee ID, the two tables can be related.

Note: Dueto the requirements Accessimposes on relationships, they are best
set up before any data exists in a database. In the course of this
process, you may need to go back your table designs and add
additional fields and primary keys or indexesin order for Accessto
create the relationships you want.

Types of Relationships

There are three kinds of linking relationships that can be established between tables. The
type of relationship that is created is determined by the indexes that exist in the Table
properties for each of the linked fields.

One-to-One

A one-to-one relationship exists between two tables when each record in one table has
exactly one matching record in the other table. For example, atable that contains
employee work information could be related to a table containing employee personal
information. The two tables would be related through a common or shared field, such as
an employeeID.

Thetwo related fields of a one-to-one relationship must both have Y es (No Duplicates)
index property settings. Thus, the fields would be primary key fields.

One-to-Many

A one-to-many relationship exists between two tables when one record in the first table
matches many records in the second table, but one record in the second table matches
only one record in the first table. For example, in an employee table, each employee
would have only one record identified by employee ID. However, in atable of assigned
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projects, each employee would have their employee ID listed multiple times because
employees work on more than one project at atime.

In aone-to-many relationship, the primary field in the primary table hasa Y es (No
Duplicates) index property setting, while the related field has a Y es (Duplicates OK)
index property. Hence, the employee ID field in the employee table would be a primary
key field, while the employee ID field in the assigned projects table would be aforeign
key in the relationship.

Many-to-Many

A many-to-many relationship exists between two tables when one record in the first table
matches many records in the second table, and one record in the second table matches
many records in the first table. For example, in atable of courses, each course has many
students, and in atable of students, each student can take several courses.

Note: To create amany-to-many relationship in Access (two one-to-many
relationships), you must create alinking table. The linking table will
contain the primary key from both tables that can be set as a primary
key field together and act as the foreign key for the relationships.

Enforcing Relationship Rules

When you create arelationship in Access, there are rules that can be enforced on them.
The principal ruleis Enforce referential Integrity. The secondary rules are Cascade
Update Related Records and Cascade Delete Related Records. Theserulesare as
follows:

Enforce Referential Integrity

Enforcing referential integrity ensures that for each record in the primary or parent table
of arelationship, there is a corresponding record in the related or child table. For
example, enforced referential integrity would mean that a student enrolling in a class
could not accidentally be added to the database without the class being listed. Depending
on the data and the relationship, you may or may not want to select this option.

If you select Enfor ce Referential Integrity, you can aso select the following options:

Cascade Update Related Fields

This allows you to change the key value in the primary table and have the same
information updated in the related fields of the linked table(s).

Cascade Delete Related Fields

This allows you to delete records in related tables by deleting the main record in the
primary table. Y ou will receive a message to confirm the deletion.
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Creating a Relationship
To create relationships between two or more tables:

1. Open the Relationships design view by clicking the Relationships button =8 on the
Database tool bar.

2. Add the tables you want from the Show Table dialog box. To do this, click on the
table once and click the Add button and continue to do this for each table you want to
add. To quickly add more than one table at atime, click on the table name once, hold
the Ctrl key or Shift key on your keyboard, and click on the remaining tables each
onetime. You can aso click and drag on the table names you want to add to the
relationship window if they are adjacent. When you have finished click on the Close
button.

Show Table

Tables lQueries l Baoth ] Add

AssignedProject Table Close

EmpInyeePersnnaIInFDTable
EmployveswworkInfoTable
PraojectTable

Note: If you have previously created and saved a Relationships design for
your database, you can add tables to your Relationships design by

clicking the Show Table button & on the menu bar.
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3. Arrange the tables in the Relationships design.

Microsoft Access - [Relationships]

Dﬁ File Edit Wiew Relationships Tools wWindomw Help

L E=R m 8B X Ba- @,

EmployeelD
EmployesFirstMame
EmployesriddleInitial EmployeelD
EmploveelastMame ErnpProjStartDate
FulltimeEmploveePosition EmpProjEndDate
EmployeeHireDate £
Employvesyearkyalary
Employvesivorkaddress
EmployesBuildingianme
Employesbepartment

ProjectlD

[£

4. Createthe link between the fields of two tables by clicking on the primary key field
namein onefield list and dragging it to the field in the other field list that contains
the same type of data. Remember that they do not have to have the same name.

Edit Relations hips

Table/Cuery: Related TableQuery:
| - =
ErnployveeID _~ | EmplovesID ~ ﬁ
E Join Type..
L
[ Enforce Referential Integrity m
-
-

Relationship Type: Cne-To-Many

5. Select enforcement criteria for the link, such as Enfor ce Referential I ntegrity,
Cascade Update Related Fields, and Cascade Delete Related Fields.
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6. Click Createto apply the rules and construct the relationship.

Microsoft Access - [Relationships]

=5 Fle Edit Wiew Relationships

e E® BBl X @ E- 3.
EmployeeFirstiame
EmployeemiddieInitial
Employvesl astMame EmpProjstartDate
FullkimeEmployeePosition EmpProjEndCate
EmployvesHireDate MNotes
EmplovesiearlSalary TimeSpent
EmploveswWorkaddress
EmployvesBuildingiane
Employeelepartment w

Note: Whenyou make arelationship, Access automatically savesit. You do
not have to click on the Save button. If you enforce integrity in aone-
to-many relationship, Access will show you the one side of the
relationship by placing a 1 beside the join field in the primary table
and an infinity symbol beside the many table.

Modifying a Relationship

Sometimes, you might need to modify or delete your relationships. To change the rules
or modify arelationship, simply point to the join line with the tip of the mouse pointer
and double click onthe join line. The relationship dialog box will open for you to
modify the rules. Once you are finished you can click on OK.

To delete arelationship, you can use the tip of the mouse pointer to click on the
relationship join line one time. When the lineis highlighted (it will turn into athicker
black line), you can press Delete on your keyboard. You'll receive the following dialog
box:

Microsoft Access

! "_l., Are you sure vou want to permanently delete the selected relationship From your database?

Yes Mo

Click OK to proceed with deleting the relationship.

Note: Thisisonly apermanent deletion because you cannot click on undo to
reestablish it. However, you can click and drag one field and drop it
on top of its matching field and create the relationship again.
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Getting Additional Help

ACS provides consulting and Q& A help in avariety of ways:

785/864-0200
question@ku.edu
www.ku.edu/acs/help

To evaluate this course online, please visit www.ku.edu/acg/training/eval uation

Last Update: 09/02/2003
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Appendix - Subdatasheets

Subdatasheets are actually tables (or datasheets) that are nested inside of other tables.
Subdatasheets can be added to tables, queries, or forms. Theinformationin a
subdatasheet usually comes from the “child” or “many” table, although it does not have
to. We can then use subdatasheets to view and edit datain other tables.

Inserting Subdatasheets into Tables

There are a several waysin which you can insert a subdatasheet into an existing table.
Usually subdatasheets are inserted automatically by Access after rel ationships have been
established, although you can do it before creating relationships. However, if the table
you're inserting a subdatasheet into isin more than one relationship, Access will prompt
you to select which subdatasheet you' d like to insert. Here is how it works:

1. Open the table that you want to insert a Subdatasheet into.
2. Click on Insert=»Subdatasheets...

Insert Subdatasheet

Tables lQueries] Both ] ok,

AssignedProjectTable Cancel

EmploveePersonallnfoTable
EmployvesiWorkInfoTable
PrajectTable

Link, Child Fields: |Em|:u|u:|yeeID j

Link Master Fields: |En'||:|ln:|':.feeID ﬂ

3. When the Insert Subdatasheet dialog box opens, click on the table name that you
want to insert.

a.  When you choose the table name, if the join fields from the tables have the same
name and a relationship has been established between the tables, then Access will
recognize this and automatically fill in the Link Child Fieldsand Link Master
Fields boxes.

b. If thefield namesdo not automatically appear in the boxes, click on the drop
down arrow of each box and choose the correct field to link the two tables.

Click OK.

When you close the table, if you want to save the insertion of the subdatasheet, make
sure you answer Y es to saving changes.
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Expanding and Collapsing Subdatasheets

If you want to view or edit the information in a subdatasheet, you must expand it. There
are several ways in which you can do this. If you want to expand only one record in the
subdatasheet, you can click on the plus sign beside the main record whose related record
you want to concentrate on. The plus sign will change to a minus sign, so that when you
have finished with the related record, you can click on the minus sign to collapse the
datasheet’ s record.

Y ou can aso expand or collapse the entire datasheet at once. Under
Format=»Subdatasheets... thereis an Expand All and Collapse All option. These two
options allow you to expand or collapse all of the records in the subdatashest.

Removing Subdatasheets

Y ou can also remove subdatasheets from your table, query, or form. To remove a
subdatasheet from atable, do the following:

9. Click on Format=>»Subdatasheets...
10. Click on the option that says Remove Subdatasheet.
11. The subdatasheet will be removed from your table.
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